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The release of a new version of Microsoft Office is an event, be it for the Mac or
Windows platform. The arrival of Office 2001 for the Macintosh is especially
significant, because it provides up-front and personal evidence that the world’s

largest software company is firm in its resolve to deliver top-quality software for our
favorite computing platform.

For the new version, Microsoft has gone the extra mile to ensure that ease of use is
a primary feature. In the past, the company’s programs have been regarded as having
huge feature sets buried in arcane menu bar commands and dialog boxes. The learning
curve was steep, and huge instruction manuals and comprehensive help menus were
needed to get users up to speed.

But even if the information you need is now embedded in the software, the lack of a
user manual means that you no longer have a convenient reference to guide you along
the way. That’s the purpose of this book: to help you harness the power of Office 2001
for the Macintosh and create documents that will allow you to express your creativity
and present information in the most productive way.

In this chapter, we’ll explore many of the new features of Office 2001.

New Features of Office 2001
The biggest problem in creating a document is just getting started. Which Office
program do you use? How do you select the right document format to meet your
needs? The following pages list many of the most important new features of Office.
You’ll find full instructions on how to take advantage of them in the other chapters
in this book.

Did you buy the Office applications separately? Excel 2001, PowerPoint 2001, and
Word 2001 are available in separate retail packages. You can use the chapters in this
book that refer to those programs just as if you had bought the entire Office package in
one box (make that CD).

Introducing the Project Gallery
Microsoft’s answer to the dilemma of how to get started is the Project Gallery (see
Figure 1-1). This floating palette is sort of a one-stop shopping center that lets you
select the kind of document you want to create and then choose from a wide array of
templates and wizards to set up that document. You don’t even have to specify which
application you want to use. Based on the choices you make in the Project Galley, the
correct application will be selected and opened for you, automatically. We’ll cover this
subject in more detail in Chapters 3 and 4.
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If you’ve used AppleWorks 6, you’ll find something familiar about the Project Gallery.
It resembles the Starting Point feature of Apple Computer’s integrated software package.

The Formatting Palette Simplifies Document Setup
In previous versions of Office, you had to figure out toolbar buttons and pore through
a byzantine array of menu bar commands and dialog boxes to handle even the basics
of document formatting, such as setting text size and line spacing. With the Formatting
Palette (shown in Figure 1-2), this is all simplified greatly. The palette’s contents change
automatically depending on the Office feature or program you’re using, and many of
the commands you’ll use most are just a click or a pop-up menu away.

Figure 1-1. The Office 2001 Project Gallery is a convenient starting point for
creating new documents.
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Figure 1-2. In this example, the Formatting Palette displays many of the Word
commands you’ll use most often. The choices change if you switch
to Excel or PowerPoint.
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Support for New Open and Save Dialog Boxes
Apple’s enhanced Open and Save dialog boxes, sometimes called navigation services,
are fully supported by Office 2001 (see Figure 1-3). The Shortcuts feature lets you jump
right to the desktop, the drives available to your Mac, or networked Macs. A Favorites
feature lets you add folders and disks for fast access. Recently accessed documents are
also listed.

Introducing Microsoft Entourage
Microsoft’s free Outlook Express has been regarded as one of the best e-mail programs,
even when compared to a popular commercial alternative, Qualcomm’s Eudora. In
addition to managing your Internet e-mail accounts and newsgroups, the program has
a convenient Address Book feature that stores basic contact information beyond the
e-mail address, including phone numbers and physical addresses.

Microsoft took this worthy beginning and melded it with a personal information
manager (PIM) and dubbed it Entourage (see Figure 1-4). As you’ll learn in Chapters 5
through 10, this new application compares favorably with separate PIM software, but
it’s also well integrated into the Office application suite.

Figure 1-3. Apple’s fancy new Open and Save dialog boxes get full support from
Office 2001.
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Here are the main features of Entourage:

■ Easy E-mail Management A convenient three-pane window displays e-mail
and information category folders, a list of e-mail messages, and the text of the
selected message. You don’t have to open your message in a separate window,
which eases management of messages. This window setup is especially
convenient if your Mac has a small monitor.

■ Smart Address AutoComplete When you address a message, Entourage
offers to complete the address based on your Address Book contacts and the
most recent contacts with whom you’ve exchanged messages (even if they are
not in your Address Book).

■ Address Book In addition to providing basic contact information, such as
name, e-mail address, phone number, and location, the Address Book provides
an Action button, which you can use to create a new message or even locate the
contact by logging onto the Internet and consulting Microsoft’s Expedia Web site.

Figure 1-4. Entourage is a new e-mail and personal information manager application
based on Outlook Express.
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■ Easy-Access Calendar Accessed by a single click from the main window of
Entourage, the Calendar (see Figure 1-5) can be used to create new events or
tasks and manage existing ones. The Calendar can be published on your Web
site or sent as an e-mail attachment to your contacts.

The Calendar automatically resizes itself depending on the size of your document
window and the space allocated to the folder list.

■ Task Management You can build a personal to-do list, where you can enter
tasks and set reminders on a one-time basis or for repeating events.

■ Electronic Sticky Notes If your office is cluttered with those paper sticky
notes, you’ll appreciate the ability to create electronic versions in Entourage.
You can write down ideas, recipes, directions to a contact’s office and so on.

The Sticky Notes feature of Microsoft Entourage is separate from the feature offered as
part of the Mac OS. For one thing, it works only within the program, whereas Apple’s
Stickies feature puts your notes on the desktop.

Figure 1-5. Entourage’s Calendar can be used to enter tasks or reminders, or it
can be published on your Web site.
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■ Electronic Reminders You’ll see a reminder at the specified time for special
events, tasks, or messages that require follow-up. Entourage reminders can be
created for Microsoft Office documents that require follow-up.

■ Custom Views and Categories You can organize your personal information
the way you want, making it easy to prioritize messages and events and locate
the data you need.

■ Links This unique and powerful feature of Entourage lets you attach a link
to a message or file, even if that file was created in a program that’s not part of
the Microsoft Office 2001 suite. This feature allows you to open the linked item
without having to perform a special search for it—a real time saver.

■ Word Text Editor Your Entourage messages use some of the same basic
editing tools as Word. You can check spelling, apply text formatting, and
automatically correct the words you frequently misspell.

■ Advanced Find You wrote a message, but with hundreds or thousands in
your archives, how do you find the one you sent to a specific person on a
specific day? Entourage’s Find feature can search your messages by content
or category.

■ Easy Import of Existing Messages Whether you used Outlook Express or a
totally different e-mail program, such as Eudora or Netscape Communicator,
you can import both messages and address books with a reasonable degree of
fidelity. A convenient assistant takes you through the process.

■ Multiple Users With Mac OS 9, Apple introduced systemwide support for
multiple users. This allows the owner or administrator of a Macintosh to set
up a custom environment for each user. Entourage supports this feature, so
each user can have his or her own account information, messages, reminders,
and so forth.

Introducing Word 2001
Here, one by one, are brief descriptions of the new features of Word 2001. Following
this list is a roundup of the changes in commands as compared to Word 98, so you
can see how to access familiar functions with the new version of the program. You’ll
discover the power of Word 2001 in Chapters 11 through 15.

■ Templates Rather than creating your document formatting from scratch,
Word 2001 offers you hundreds of templates to help simplify the process
of getting started. A template is simply a document with all the formatting
elements in place, ready for you to customize or insert your information.
They’re defined by category, so you can easily select the ones that apply
most to your project. The Value Pack on your Office 2001 installation disk
(described in Chapter 2) includes extra templates and clip art for you to install.
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If you choose a template or wizard that requires a different application than Word, no
problem. Once you’ve set up your document, the appropriate Office application will be
launched if it’s not already open.

■ Wizard Sometimes known as an assistant, a wizard helps step you through
the design process, so you can easily build a document or use a particular
program feature without having to enter all the formatting information
manually. Word 98 offered wizards for such tasks as creating envelopes
and labels. The new version adds more sophisticated offerings, for working
with such projects as brochures, catalogs, and menus (see Figure 1-6).

■ AutoCorrect Having a powerful Mac at your beck and call isn’t enough. What’s
the good of having all that computing horsepower at hand if it cannot do at least
some of the work for you, so you don’t have to manually enter every command
or function? The new AutoCorrect function still finds and automatically corrects
typing errors, such as misspellings and typos, and grammatical errors and so on.
But it goes further than the feature in the previous version of Word by using the
same dictionary as your spelling checker. Take it from me; this book would have
been far more difficult without this feature (I tend to reverse letters when I type
really fast, which is most of the time).

C h a p t e r 1 : D i s c o v e r i n g O f f i c e 2 0 0 1 11

Figure 1-6. Use a wizard to guide you through the formatting of the most
complex projects.
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■ Automatic Formatting Compared to earlier versions, Word 2001 has a more
inspired automatic text formatting feature, which examines document formats
that you use for a list item, such as this one, and then applies the same
formatting to the next item. In this case, I typed the heading in bold, so Word
knew enough to begin the next item in bold as well (even though I was typing
in normal text when I ended the previous entry). Word is even clever enough
to apply common formats to text entries: for instance, if you regularly place
asterisks before and after a word to signify bold. For example, typing *Bold*
would yield Bold, with the word typed in boldface (without your having to
switch back to regular typeface after that word).

■ AutoComplete When you begin to type a word or phrase, Word can
recommend how it may be completed, based on the entries in your Entourage
Address Book, dates, and entries in the AutoText panel (opened from the
AutoCorrect command). When I type Gen in my copy of Word, for example,
the program comes up with “Gene Steinberg” to complete the entry (of course,
your mileage may vary, unless you have some reason to put my name in your
Address Book).

■ AutoSummarize This feature allows Word to examine the contents of a
document and then provide a summary (see Figure 1-7) based on its analysis.
While I would not suggest this as a way for a student to write a report for
homework (in case you are a student reading this book), it’s a useful way
to create an abstract of a complex document to get a sense of the basic
subject matter.

■ Automatic Style Creation and Preview In previous versions of Word, you
had to manually create a new style based on the formatting of a paragraph. In
Word 2001, the style is created for you as you alter the formatting. In addition,
styles are updated based on the changes that you make.

To see a small preview of the impact of your style, just select Style from the Format
menu and click the style’s name. Both character and paragraph styles are shown
in miniature.

■ Letter Wizard One of the most common uses of a word processing program
is to write letters. In Word 2001, the Letter Wizard takes you step by step
through the formatting of the kind of letter you want, be it a formal letter
or just a personal note to a friend or family member. What’s more, the names
of those to whom you’ve written are stored in a list, along with the contents of
your Entourage Address Book. That way, your new letter can be addressed
automatically for you. Even your salutation and closings are stored, in case you
wish to move beyond a simple “Dear John” beginning and “Cordially” ending.
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■ Click and Type Want to insert a header or footer in your document (such as
a book’s title or page number)? It’s easier with Word 2001: all you have to do is
double-click a footer or header in the document where you want to place the
entries. This click and type capability is also useful for adding graphics and
tables to your document.

■ Checking Spelling and Grammar Spelling and grammar checking are tasks
where a word processor sometimes falls down on the job. Grammar checking
tends to be a little too literal, and spell checkers miss proper names of people,
places, and things. Suggestions for grammatical errors are now presented in a
more informative, less rigid fashion. In addition, as explained earlier in this
section, AutoCorrect has been beefed up to offer near-automatic spell checking
and correction of common errors. The result is a cleaner, more error-free
document in less time.

Figure 1-7. This is a short summary of a novel written by the author and his son.
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Just hold down the CONTROL key and click a word, and Word will provide a pop-up
listing of synonyms in the contextual menu. There’s also a Define category, which lists
the dictionary definition of the word, as shown here.

■ New Find and Replace Feature Say you want to change the word scissor to
knife. With the previous versions of Word, you also had to seek out several
grammatical inflections: for example, you had to replace scissors with knives,
and so on. The new Find and Replace feature intelligently changes all or most
of these variations without your having to go through the process several times
(which can get to be time consuming on a large document). Remember, the
more a computer computes, the easier it is for you to get your work done.

■ Multiple-Language Hyphenation You can install multilingual dictionaries
in Office, using the Value Pack installer on your Office CD. When Word detects
material in your document written in a different language, it will hyphenate
accordingly, if document hyphenation is activated (it’s activated via the
Hyphenation command on the Tools menu).

■ New Table Drawing Tools Word’s extensive array of illustration tools have
been enhanced for tables. Just a click and a drag is all you need to create a
boundary around a table or one of the cells within a table. A convenient Eraser
tool is on hand to remove any portion of the table, so a portion of the table can
be merged. In Word 98, this feature was limited to cells in the same row. Now
it works across the board.

■ Nested Tables Want to create a table within a table? In Word 2001, you can
do it with a click and a drag. Just drag and create your table within a table as
easily as you create any other table. We’ll cover this subject in more detail in
Chapter 13.
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■ Aligning Text The text alignment options now include two convenient
document layout features. One lets you align text horizontally on a page, and
the other lets you align it vertically, aligning the text with the top or middle or
setting it justified (which spreads the space between lines to fill your page).
These options are similar to the features available on page layout software,
such as Adobe InDesign and QuarkXPress.

■ Rotate Text Another convenient page layout feature is the ability to rotate
text 90 degrees. Rotation is performed globally, either in your document or
in individual table cells or text boxes.

■ New Table Formatting Options In Word 2001, you can now adjust the height
of a table by dragging the border of the row up or down, in the same fashion as
you can control the width of a column. A move handle lets you place the table
elsewhere on a page, and a resize handle lets you alter the size but retain
current row and column proportions.

■ Updated Border Styles Included in Word 2001’s bag of tricks are 150
brand-new border styles. You can choose from such fancy effects as
three-dimensional borders, plus multiple line borders suitable for page layout.
In addition, the new Text Border feature allows you to block out text elements,
which simplifies the process of adding a special border around a headline.

■ Shaded Text You can now apply a shade or color to just selected letters or
words, not just an entire paragraph as before.

■ Enhanced Drawing Tools Although a word processor program isn’t the ideal
environment for illustration, Word 2001’s drawing and graphics tools have
been expanded with special three-dimensional effects, shadows, textures,
transparent fills, and AutoShapes—a palette of 100 forms that you can use to
spruce up your document, as shown here.

In addition, pictures can be placed in any location in your document, and
you can run text around a picture. This gives Word some useful page layout
capabilities.
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■ Text Boxes If you use a page layout program, such as QuarkXPress, the
concept of a text box is familiar. It involves putting text in a predefined area
or box, which can then be enhanced with artistic effects, rotated, resized, or
cropped. You can also link two or more text boxes, so text flows into different
columns of a page. This feature makes it easy for you to create a club newsletter
or other publication without having to resort to one of those other programs
for the task.

Although Word is offering more and more page layout features, it’s not meant as a
replacement for sophisticated page creation applications such as Adobe InDesign and
QuarkXPress. It is useful, however, for smaller, in-house publications and simple
brochures, where formatting capabilities and the precision of typography and image
placement are not as significant.

■ Picture Bullets A normal text bullet, commonly used for lists (such as in this
book), consists of a small, black (or colored) circle. Word’s Picture Bullet feature
lets you use a picture rather than a type element as a bullet.

■ Clip Gallery Organizing your clip art has never been easier than with Word’s
Clip Gallery. This new feature lets you organize your artwork into a convenient
storage area from which you can select and drag and drop images into your
documents. What’s more, it works with all Office programs, not just Word.

■ Scanner and Digital Camera Support You can access TWAIN-compatible
scanners and digital cameras, so you can scan a picture directly into Word.

TWAIN is an acronym for “tool without an interesting name,” and it allows programs
to offer direct access to special software, such as scanning software. Not all scanners
and digital cameras support TWAIN. You’ll need to consult the documentation for the
product, or just check the contents of the TWAIN folder, located in the Preferences folder
within the System Folder, to see if drivers for the product are present.

■ Web Integration In previous versions of Word, you could save your
documents in HTML format for publishing on the World Wide Web. In Word
2001, the Web authoring features have been greatly enhanced. One important
new feature gives you the ability to preview the page before it’s saved in the
Web browser of your choice—no, it doesn’t have to be Internet Explorer
(although a copy is included on the Office 2001 CD). In addition, Web pages
can be optimized for best display in a browser, thus reducing file size and
creating pages that load faster. There are also tools for creating visual effects,
editing and optimizing graphics, adding sound and video, and tapping a
collection of clip art for special effects and borders.

■ WSIWYG Web Editing The WSIWYG (what you see is what you get) feature
is similar to what you find in separate Web authoring programs. You can create
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a Web page with text, pictures, fonts, sounds, and more and never get involved
in the raw HTML code on which it’s based; you just have to look at the end
result, fully formatted (see Figure 1-8). If you like, of course, you can view the
HTML source code to perform fine-tuning.

Figure 1-8. This sample Web page, viewed in Microsoft Internet Explorer, shows
how you can produce some sophisticated work with Word’s HTML
editing features.

P:\010Comp\CompRef8\168-3 (reprint)\ch01.vp
Monday, November 12, 2001 12:38:41 PM

Color profile: Generic CMYK printer profile
Composite  Default screen



18 O f f i c e 2 0 0 1 f o r M a c : T h e C o m p l e t e R e f e r e n c e

Complete Reference / Office 2001 for Mac: TCR / Steinberg / 3168-3 / Chapter 1

■ Data Merge Manager One particularly useful feature of Word, though
difficult to use, is Mail Merge. Word 2001 makes it easier to create form
letters, envelopes, labels, and other documents. Using simple drag-and-drop
techniques, you can organize your data fields so they show up in the right
place. When you’re done, you can preview the document before printing to
make sure everything is placed correctly.

■ Expanded Multilingual Support If you’ve earmarked your documents for
use around the world, you’ll be pleased with Word 2001’s ability to handle the
requirements for foreign language text. Such elements as special characters,
euro styles, special date formats, and Word’s powerful formatting tools are
customized to meet specific language requirements.

Word Command Changes
With so many changes in the program, it may seem confusing that the basic menu
bar commands are essentially the same. Table 1-1 lists the changes and additions that
apply to common Word features. This will help you adapt to the new features and the
reinvention of old ones.

Word 98 Word 2001

File Menu

New Changed to Project Gallery.

Save as HTML Changed to Save as Web Page.

Edit Menu

Publishing Publish & Subscribe is no longer supported.

Insert Menu

Break Click command under Break to insert breaks.

Auto Text Reference Initials, Signature, and Signature Company
removed. These commands can be restored by choosing
AutoText from the Insert menu and reinserting.

Table 1-1. Word Menu Bar Commands Changed for Word 2001
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Word 98 Word 2001

Format Menu

Style Gallery Transferred to Theme dialog box.

Tools Menu

Language Thesaurus and Hyphenation functions moved to
Tools menu.

Mail Merge Now called Data Merge Manager.

Envelopes and Labels Split into two commands: Envelopes and Labels.

Preferences Now where it should be: on the Edit menu.

Table Menu

Insert Table Transferred to the Insert menu and renamed Table.

Delete Cells Choose Delete from the Tools menu and select Cells.

Select Row Choose Select from the Tools menu and select Row.

Select Column Choose Select from the Tools menu and select Column.

Select Table Choose Select from the Tools menu and select Table.

Distribute Rows
Evenly

Available under AutoFit.

Distribute Columns
Evenly

Available under AutoFit.

Cell Height and Width Available under Table Properties.

Headings Changed to Heading Rows Repeat.

Convert Table Choose Convert from the Tools menu and select
Convert Table.

Show Clipboard Moved to a more logical position, the View menu,
and renamed Office Clipboard.

Table 1-1. Word Menu Bar Commands Changed for Word 2001 (continued)
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Table 1-2 summarizes the commands new in Word 2001 and where to find them.

New Command Function

File Menu

New Blank Document Similar to the New command in Word 98;
creates a brand-new, blank document using
the default template.

Web Page Preview Opens your selected Web browser to view
Web page.

View Menu

Contact Available under Toolbars; used to configure
your Entourage Address Book.

Formatting Palette Displays a convenient floating palette
of common commands.

Insert Menu

Horizontal Line Available under Picture; inserts a graphic
file or horizontal line in your document.

From Scanner or Camera Available under Picture; inserts a picture directly
from your scanner or digital camera.

HTML Object Allows you to insert objects such as sounds,
scrolling text, and form buttons in your Web page.

Format Menu

Theme Allows you to create a document based on
a preset set of background images, colors,
and document styles.

Table 1-2. New Commands Available from the Word 2001 Menu Bar
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Introducing Excel 2001
Although Microsoft Word 2001 may get most of the attention, Excel 2001 (see Figure 1-9)
has its share of changes that will greatly simplify the often convoluted process of
creating a spreadsheet. We’ll cover this subject in more detail in Chapters 16 through 19.
Here’s a brief listing of the changes and improvements:

■ Project Gallery As in all other Office applications, the Project Gallery serves
as the convenient starting point for creating a new document. You can open a
blank document page (known as a workbook in Excel) or choose from a variety
of templates and designs.

■ See-Through View This feature keeps the color of all selected cells containing
colored text the same, rather than reversing the color scheme. This approach is
likely to be less confusing.

■ Euroconvert This feature offers easy conversion of numbers to euros and
European Union (EU) member currencies (the new currency system supported
in Europe). It also allows you to convert a figure from one euro currency to
another, by way of the euro.

New Command Function

Tools Menu

Dictionary Accesses the built-in dictionary.

Flag for Follow Up Works with Entourage to set up a reminder that
informs you when it is time to resume work on
your document.

Help Menu

Turn Assistant On/
Turn Assistant Off

Activates or turns off the animated Office Assistant.

Table 1-2. New Commands Available from the Word 2001 Menu Bar (continued)
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■ Flag for Follow-up This feature works with Entourage. It allows you to flag
your Excel workbooks for later follow-up reminders.

■ Scanner and Digital Camera Support This feature works with
TWAIN-compatible scanners and digital cameras, allowing you to scan
a picture directly to Excel. Scanned pictures can greatly enhance the look of
your workbooks and charts.

Figure 1-9. Using Excel, you can create sophisticated spreadsheets and charts
in minutes.
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■ Shared Office Tools Because certain features are shared across all Office
programs, it’s easier to learn how to access and use a program feature.

■ Border Drawing Toolbar This feature lets you draw borders, remove borders,
and merge borders, each with a single click. You can also change border styles
and colors using this powerful tool.

■ Calculator This feature is a dream come true, especially if math isn’t your
second language. You can enter figures in the Calculator, and it will automatically
come up with the correct formula syntax. Then you can place the figures in any
cell in your Excel document.

■ AutoSum The updated version of AddSum includes Average, Count, Max,
and Min functions, which makes it easier to create functions.

■ Four-Digit Dates Just in time for the new millennium, this feature lets you
specify four-digit, rather than two-digit, years.

■ Formatting Palette As in Word, this little feature places common program
features just a click away. The available functions depend on the type of item
you’ve selected, be it a regular cell or a drawing object. The Formatting Palette
frees you from long trips through menus and dialog boxes to access many
Excel features.
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■ WYSIWYG Font Menu This feature is identical to the one available in recent
versions of Word. You can now see the actual styles of your available fonts.

This feature can, of course, be turned off as an application preference, or if you
have a font menu modifier program already installed, such as Adobe Type
Reunion Deluxe or Action WYSIWYG.

A font menu modifier program such as the ones named here does more than just show
fonts in their actual styles. It also groups fonts by family to keep menus shorter. Action
WYSIWYG also shows fonts divided into columns, to shorten the font menus even more.
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■ Color Picker This feature lets you select the colors used in your spreadsheets
from the ones available on your Mac. No, it doesn’t offer special color palettes,
such as Pantone, like page layout programs such as QuarkXPress.

■ List AutoFill This is another tool to simplify document formatting. This
feature carries over the formats and formulas in lists, so that new items inherit
them. For a list to be extended, the formatting and formula properties must
show up in three of the previous five rows.

■ Euro Currency Symbol Excel 2001 supports new number formats to work
with the euro currency symbols.

■ List Manager This powerful new feature speeds up the process of sorting,
analyzing, and searching for data in your worksheet. You can use it to organize
your data for easy viewing.

■ AutoFilter Using the choices you make, AutoFilter displays rows of
information to help you find specific pieces of data.

■ AutoComplete The same powerful feature that is so flexible in Word checks
the text you’re typing against information already entered in the column. You
are then prompted to pick the right text to complete the entry from a list of
choices. This feature is a real time saver.

■ Display Units This feature is an addition to Excel’s powerful charting
capability. It helps you shorten numbers by specifying a display unit represented
by the number. For example, the number 50 can represent 50,000,000. A label will
appear in the chart to indicate that the figure represents millions (or whatever
unit you select).

■ Multiple-Level Category Labels If a data worksheet contains more than a
single heading level, Excel labels the axis of the chart according to the same
hierarchical categories as in the worksheet.

■ Web Page Preview As in Word, this feature lets you preview your document
in your selected Web browser, so you can make sure the Web version looks the
way you like.

■ Customize Web Pages This feature also mirrors the one in Word. From the
Edit menu, choose Preferences, select the General tab, and choose Web Options.
In the dialog box that appears, you can give your Web page a title, specify the
graphics format and display size, and make other choices to maximize the
impact of your page.

■ Manage Files and Links A Web page generally consists of text plus a set
of linked pictures. All Office programs help you manage all files connected to
your Web page, so problems don’t occur when visitors to your site attempt to
view them.
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■ International Web Support Office can save Web pages with the correct
international text parameters, so users around the world will be able to view
your pages in the correct text characters.

■ Full Support for Graphics and Objects As with other Office programs, the
graphics in your Web page are stored in GIF, JPEG, or PNG format. This allows
visitors to your site to view your graphics they way you want.

■ Pivot Table Features The PivotTable feature lets you embed reports directly
in your worksheets. The new PivotTable Report Wizard simplifies the process
for formatting the report according to your needs.

■ Data Selection and Formatting This feature is improved in Excel 2001. It lets
you carry over existing Excel formatting when you refresh or change the layout.

■ Improved Import and Analysis Features In Excel 2001, data can be easily
imported into your worksheet from other programs. You can avoid extra steps
in typing and formatting the information. Text file data can he handled in the
same fashion, retaining formats and formulas.

■ Improved Web Queries It’s now easier to perform a query, or search, of data
on the World Wide Web. The new, improved query function includes sample
Web queries to simplify the task of locating data.

■ FileMaker Import Wizard One of the missing features of Office for the Mac
has been a database program, such as Microsoft’s Access, which still remains
a Windows exclusive. However, this new Import Wizard lets you retrieve data
from Apple’s powerful database application, FileMaker Pro.

Introducing PowerPoint 2001
Microsoft PowerPoint 2001 (see Figure 1-10) has progressed way beyond simple
online slide shows. As you’ll see in the next few pages, it offers new features that let
you create powerful presentations. Chapters 20 through 22 cover this subject in detail.
In the meantime, here’s a list of the new and improved features:

■ Project Gallery As in all other Office 2001 applications, the Project Gallery
simplifies creation of a new document. Just choose the template or wizard you
want, and you’ll be able to produce a more professional-looking presentation.

■ Formatting Palette As in Excel and Word, the Formatting Palette puts
the most commonly used PowerPoint commands at your beck and call in
your document.

■ Find and Insert Slides Use the Slide Finder to check thumbnail views of
slides so you can add the ones you want to your presentation.
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■ Easily Access Word Definitions The built-in definition dictionary can be
used to define and cut and paste a word in your slide.

■ Personalize User Theme Apple’s Appearance Control Panel is fully
supported, so you can change the look of PowerPoint to suit your taste.

■ Euro Currency Symbol PowerPoint now provides full support for euro
currency values, in case your presentation is designed for viewing in Europe.

■ Multiple Slide Masters You can create a series of master slides and titles (not
just one), to increase the choices available in your presentation. Masters can also
be copied from other presentations, so you can easily give your slides a uniform
look and feel.

Figure 1-10. Access new tools to make more professional presentations in
PowerPoint.
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■ Improved Assistant You can now resize and dock the Office Assistant
window, so it doesn’t occupy too much space on your screen. This is especially
useful if your Mac has a smaller display—for instance, if you are using an
iMac—and you want to devote as much space as possible to the actual
presentation window.

■ AutoFit Text Is your text running too long? No problem. PowerPoint’s
AutoFit feature will resize it to fit.

■ New Normal View This new viewing option displays the outline, slide, and
notes all at once. Each viewing pane can be sized as you prefer, so you can
emphasize the pane that you are giving the most attention. This feature is
another boon for users with smaller monitors.

■ Grayscale Output Slides can be seen and printed in black and white, not just
color. This enhances the results if you’re using a regular grayscale laser printer.

■ Native Table Tools You no longer have to copy or import tables from other
programs. You can use the Draw Table tool to create tables within PowerPoint.
Just click the tool and drag to create the tables you want.

■ Graphical Bullets As in Word, this feature lets you use a picture, rather
than a text character, as a bullet to enhance the look of a slide. PowerPoint
offers a selection of bullet clip art, so you don’t have to create picture elements
from scratch.

■ Numbered Lists This is another Word feature that makes its debut in
PowerPoint. Just click the List button on the Formatting Palette, and you’ll
have automatically numbered lists.

■ Flag for Follow-up Again you can harness a powerful feature of Entourage
2001. Just flag your presentations for later follow up, and you’ll see an onscreen
reminder when it’s time to return to a project for updating or to send a project
to your contacts.

■ Expanded Clip Gallery This feature lets you conveniently organize the
pictures you use regularly for your presentations. You can place graphics in
special categories, add custom keywords, and place the Clip Gallery side by
side with your PowerPoint document, so you can easily drag and drop the
pictures you need.

■ Graphics and Objects for Web Pages When you publish a PowerPoint
presentation to a Web site, the pictures are automatically stored in a Web-savvy
format: GIF, JPEG, or PNG.

■ Enhanced Graphics Support This feature is especially useful if you intend
to output a presentation to a film recorder or high-end output device. Exported
slide images can be adjusted for size, resolution, and compression for
maximum quality for the intended medium.

P:\010Comp\CompRef8\168-3 (reprint)\ch01.vp
Monday, November 12, 2001 12:38:47 PM

Color profile: Generic CMYK printer profile
Composite  Default screen



C h a p t e r 1 : D i s c o v e r i n g O f f i c e 2 0 0 1 29

Complete Reference / Office 2001 for Mac: TCR / Steinberg / 3168-3 / Chapter 1

G
ETTIN

G
S

TA
R

TED
W

ITH
O

FFIC
E

2
0

0
1

FO
R

M
A

C

■ Scanner and Digital Camera Support As in other Office applications,
many scanners and digital cameras with TWAIN drivers can be used to bring
a picture into PowerPoint.

■ Animated GIF Support You can play an animated GIF file in your
PowerPoint presentation, which is especially helpful if your presentation
is earmarked for the Web.

■ Make PowerPoint Movies The recipient of your presentation no longer
has to have PowerPoint or a viewer program installed. You can save your
presentation as a QuickTime movie, providing full control of your presentation
via the controls in the player application. This allows your presentations to be
seen by anyone using a Macintosh or Windows personal computer with Apple’s
QuickTime program installed.

The latest version of Apple’s QuickTime can be downloaded directly from Apple’s Web
site at http://www.apple.com/quicktime.

■ Save as Web Page This feature matches the one in Excel and Word. You can
publish your presentation on the Web. The conversion process converts the
outline pane to a table of contents of your slides for easier navigation.

■ QuickTime Transitions Give your presentation a movie-like look and a more
fluid flow by adding transitions between slides. The Exit Animations feature
also gives you more control over special animation and sound effects.

■ Slide Navigator Just drag the horizontal scrollbar and view a thumbnail to
locate a specific slide in your presentation.

■ Improved Browser Compatibility Your Web-based presentations can be set
up to access the more powerful features of Internet Explorer or Netscape 4.0
or later, yet remain viewable with Internet Explorer and Netscape 3.0.

■ Customizable Web Pages As in other Office programs, just choose Preferences
from the Edit menu, select the General tab, and click the Web Options button.
You can use this preference panel to specify Web graphics formats.

■ Automatic File and Link Management Automatic file and link management
facilitates the handling of pictures that are linked to your Web page. Office 2001
applications can also check links and repair broken links to accommodate
movement of the main HTML file and graphics to other folders.

■ International Text Encoding Like all Office applications, PowerPoint is a
multilingual program. You can select the text encoding you want so users of
foreign language systems can see the presentation with the correct letterforms.
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New Features of Office v. X for Mac OS X
For its Mac OS X version of Office (see Figure 1-11), Microsoft worked hard at updating
the software to make it look good with the new Aqua interface. In all, some 700 program
icons were redesigned to make them attractive and functional under the new operating
system’s Quartz 2-D imaging technology.

One particularly impressive aspect of Office v. X is the genie-like way that palettes, such
as the Formatting Palette, are minimized or closed when you click the close button.

The following pages cover only the new features for Office v. X. As you’ll see, for
the most part, they enhance, rather than replace, the great features of Office 2001.

According to Microsoft, these new features are not likely to appear in Office 2001 for the
Mac and are exclusive to the Mac OS X version.
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Figure 1-11. The look of Word v. X typifies the new look for this application suite.
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■ Enhanced Compatibility Office v. X files are completely compatible with
Office 2001 and Office 98, so you can easily exchange files with Mac users who
haven’t migrated to the Mac OS X version yet. In addition, Office applications
are compatible with Office for Windows 97, Office for Windows 2000, and
Office for Windows XP. New on the compatibility list is support for
AppleWorks 6.2 and the current version of FileMaker Pro, version 5.5.

■ Revised Office Notifications Whether or not an Office v. X application is
running, appointments and tasks can be displayed in a convenient window.
This feature is also integrated with Microsoft .NET and MSN, so you can get
word of updated stock quotes and other useful information.

■ Revised Project Gallery A new feature of Office’s Project Gallery is a category
called Based on Recent. Up to 27 recent documents are displayed, and this feature
allows you to create new documents using the information in previous ones.
Since a copy rather than the original is opened when you use this feature, you
don’t have to fret over actually modifying the original document.

■ New Getting Started Booklet and Revised Help Information In response
to criticisms about the lack of a printed manual, Office v. X puts an electronic
(PDF) document in the same folder in which the suite is installed. It’s called
Getting Started Book. In addition, the Help menu has been revised, and a
print feature has been added, so you can get a hard copy of the help text.

■ Collect and Paste The Office v. X clipboard has been made more intelligent,
allowing you to go way beyond the standard copy-and-paste function. Instead
of copying one item, pasting it, and then doing the same with the next, you can
select multiple picture and text items from any Office application and then use
the Paste All feature to put them all in a single document. You can also use this
feature to apply formatting changes to the selected material. Nifty.

■ MSN Messenger Microsoft’s instant messaging client (see Figure 1-12) is the
second most popular program of its type. The Carbonized version that comes
with the Office v. X installation integrates with your Hotmail or Passport
accounts and also works with Office Notifications and Microsoft .NET to
provide extra notices about events and news. And, of course, you can track
your online buddies.

I won’t get into the ongoing dispute between Microsoft and AOL about compatibility
between the two systems. For now, you have to keep separate buddy lists for each service.
But maybe someday….

■ Web-Based Tools Microsoft’s MacTopia Web site (http://www.microsoft.com/
mactopia) offers contact information, online maps, templates, clip art, and
reference services that you can access to enhance your contact information in
Entourage or the appearance of your Word, Excel, and PowerPoint documents.
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■ REALbasic Support If you’ve played with Microsoft’s Visual Basic on the
Windows platform, you’ll appreciate the ability to develop custom user
interfaces and macros for your specialized documents.

Introducing Microsoft Entourage X
Office v. X offers a major update to the user interface of the newest element of the
Microsoft Macintosh Office suite, Entourage X (see Figure 1-13). The revised UI takes
advantage of the Mac OS X Aqua interface and offers greater flexibility and control in
managing your contacts, Calendar, and event notices, as well as the ability to manage
your e-mail.

■ Enhanced Calendar The redesigned Calendar (see Figure 1-14) gets a spiffy
tri-pane interface for daily, weekly, or monthly schedules, plus a new Tasks list
that displays the events you need to know about. Entourage X is also integrated
with Outlook, so you can send and receive meeting requests in installations that
use Microsoft’s Windows-based Exchange Server system.

■ International Address Book Support When you need to add contacts from
different locales around the world, Entourage X’s updated Address Book can
support the unique address formats used in Europe, Japan, and many other
countries.

Figure 1-12. MSN Messenger is Microsoft’s popular instant messaging client.
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■ Enhanced Custom Views To help you find the information you need at a
moment’s notice, a modified Custom Views tab lets you examine your Address
Book, Calendar, and Notes in the same place.

■ Expanded Word Editing Tools When you write e-mail, you are using many
of the same features that you’d access in Word. By integrating Word features
into Entourage X, Office v. X lets you move between the two programs without
having to learn different ways of doing things. One particularly useful feature
is Multiple Undo, something that is already part of Word 2001 and Word X.

■ Insert Rich Content If you’ve used AOL, you’re familiar with a feature that
allows you to embed pictures in your e-mail messages. Entourage X’s Insert
Rich Content feature takes this capability a step farther, allowing you to also
place video clips in the body of your message.

To view rich content, the recipient of your message must have software that supports
this feature. Not even AOL would necessarily embed rich content from Entourage X
in an e-mail message; however, usually embedded pictures would be included as file
attachments, so the recipient should be able to see them, even if not in the body of
your message.

Figure 1-13. Sporting a new look, Entourage X is the element of the Office suite
most changed in Office v. X.
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■ Keychain Support Mac OS X’s Keychain lets you store all, or most, of your
passwords in a single location, so you don’t have to hunt for them. Entourage X
fully supports this oh-so-useful feature.

Introducing Word X
In the Mac OS X version of Word, the primary changes (other than those that apply to
all Office applications) are visual. The new version provides complete support for the
marvelous features of Apple’s new operating system.

In addition, there are a few notable changes that you’ll treasure when you try them:

■ Multi-Selection This feature, similar to one available in Nisus Writer, another
word processor for the Mac, lets you separately select multiple and separated
elements in your Word document by holding down the COMMAND key and
clicking. You can then apply format changes or search in those elements
alone—a real time-saver. Or you can cut or copy all of the items in one operation
and paste them as a single item in another part of your document (or access
Word’s drag-and-drop feature for a similar effect).

Figure 1-14. You’ll appreciate the easy way you can track your tasks and events
with Entourage X’s refined Calendar view.
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■ Clear Formatting Do you ever run into trouble when trying to remove and
change complicated document formats? Word X’s Clear Formatting feature, on
the Edit menu, zaps the formatting in a single step, switching the selected items
to your default text style.

Introducing Excel X
The sophisticated spreadsheet component of Office v. X, in addition to getting the
requisite Aqua makeover (see Figure 1-15), also includes some highly useful capabilities
to help you protect and enhance your document.
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Figure 1-15. Mac OS X’s Quartz imaging capabilities are exploited in Excel X.
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Here’s the short list:

■ Auto Recover This feature is already present in Word. By default, your
document is saved every 10 minutes. Should a power outage or system crash
occur, the next time you open Excel X, you’ll see the recovered version of your
document. As in Word, you’ll be able to get back to work without having to
redo a large segment of your document.

■ Customizable Keyboard Shortcuts If you find that the keyboard shortcut
changes from Excel 98 to Excel 2001 are daunting or confusing, Excel X lets you
change them to the way you like. Just as in Word, you can customize keyboard
shortcuts in the way that makes you most comfortable, so your productivity is
enhanced.

■ Transparent Charts and Anti-Aliasing These features exploit Mac OS X’s
Quartz 2-D imaging technology. Your Excel X charts are sharply rendered,
and you can use the transparency features to improve the impact. This can save
you from a trip to another program, such as Adobe Photoshop—another real
time-saver.

Microsoft isn’t exaggerating when touting the enhanced graphics capabilities of Excel X.
The first time I showed a simple chart made in Excel X to a graphic artist, she refused to
believe that I had actually created it in Excel and not a dedicated graphics program.

Introducing PowerPoint X
Changes to PowerPoint X are extremely light, aside from appearance and usability
enhancements related to Mac OS X.

The most notable new feature, Packages, lets you collect all of the elements of a
presentation, such as images, movies, and sounds, and put them in a single folder for
easy transport to other users. This feature is reminiscent of the “collect for output”
capability you find in dedicated page layout programs, such as Adobe InDesign and
QuarkXPress.

Summary
Although the contents of the menus and dialog boxes in Excel, PowerPoint, and Word
appear similar to those in Office 98 (aside from the obvious Aqua-related changes in
Mac OS X), in fact, vast changes have been made to make Office’s powerful features
easier to use. This means that you can create even complex documents more quickly
than ever before.

In the next chapter, we’ll explore Office 2001 and Office v. X installation, from
the simple drag-and-drop setup to complex, custom installations configured to match
your needs.
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